RoboMiner User Manual

What is RoboMiner?

Welcome to RoboMiner, an
automated foreign exchange trading
system, or Expert Advisor, that runs on
the Metatrader 4 platform. Before you
can use RoboMiner, you must download
Metatrader 4 from a broker, and open an
account. A demo account is
recommended for those learning foreign
exchange or getting started with
RoboMiner.

Installing Metatrader 4

Getting Started

MetaTrader 4 can be downloaded
from any broker that uses the platform to
manage its customers’ foreign exchange
trading. The steps in opening a demo
account and downloading the platform
are outlined here, using the /nterbankix
version for demonstration purposes.

1. Navigate to the /nterbankfx Home Page at

practiceaccount

http://interbankfx.com/Default.aspx.

2. On the /nterbankfx Home Page, click on the

practiceaccount box.

3. On the Demo Account
page, fill out the form to
Request a Demo
Account. Be sure to
specify Metatrader 4
under Platform Version.

4. Press Submit Request,
and a pane will appear
telling you whether your
request was successful.
Press the Download

MT4 Platform button to start the
download, and save the file to your
desktop or in a convenient folder.

get yours today
for FREE

Request a Demo Account

*First Name *Last Name

*Count *City/Town
ISeIectCountry 'l
*State / Region *Phone

=Platform Version

“Email Address
I Select Platform 'l
Trading Experience How did you hear about us?
ISeIectOijon 'l ISeIectOption 'l

Please provide a valid email address. i
Platform download links will be emailed to the address you provide. A

Submit Reguest | Reset |

Successfull Request

Thank You John Doe

You will recieve an email containing a link to the
platform. If you would like to download it
immediately, use the link below.

®m Download MT4 Platform

For details about using the many features of
Metatrader 4, visit Interbankfx University at

http://interbankfx.com/Ibfxu/Default.aspx.
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==Note, if you don't see an email from us in your
inbox, you may want to check your bulk or junk
folder, as it may end up there.
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5. Double click on the MT4.exe icon
to install the Metatrader 4
platform. After a series of \ Interbank fX Trader
preliminary setup screens, the =
final screen of the Interbank FX
Trader setup sequence will
appear. Press Finish and
Metatrader will launch.

k FX Trader 4.00 setup

N.B. Bear in mind that the
installation procedure and screens
will vary from broker to broker, as
the MT4 platform is customized for
each broker.

Open an Account 7] x]

6. The Open An Account Personl dets _—
dialog box will appear o open an socourt, plesse fil ut althe follwing fiekds:

when the MT4 platform
opens. Fill in the
information for your
Demo Account. Before
you can proceed you must
check the box indicating
that you agree to
subscribe to the broker’s
newsletters.

Note: For trading 2
currency pairs, you may
wish to open a standard
account with 1:200
leverage and a $3,500
deposit, or a minimum
of $2,000 for just the
AUDNZD and $2,500 for
just the EURCHF.

W InterbankFX-Demo Accounts | Interbank FX, LLC

7. Click Next, and you will
be taken to a screen
showing one or more
servers to which your
platform will be
connected for trading.
Select a server, if necessary, and click Next.
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8. Details of your demo Saslalaal
account will now
appear in the
Registration
window. Make a note
of the Login,
Password, and
Investor information.
Then press Finish.

9. The Metatrader 4
platform window will
now open. Depending
on your broker’s
customization, one or
more currency pair charts
may be open in the
window. You may close
these for the time being by

Interbank FX Trader 4
festire % USDCHF | 11335 1.133%
& 178216D: John Doe 4 GBPUSD = 15840 1.9844

Indicators 4 EURUSD 1.4533  1.4601

L ; _ Bxpeit Advisors 9 USDJPY | 111700 111.73
clicking on the x in the e wanuss | ogl ne
upper left corner of each & . Scripts v Uscrn | ogsz | 09
Chart pane' 4 EURGEF 0.7357 0.7360

4 EURCHF 1.6550 1.6554

10. If they do not appear in @ EURJFY 16208 16312
the MT4 window, open the ¥ GBPJPY | 22180 22165
Market Watch, & GEPCHF 22485 22458

- . 9 EURAUD 16641 16645
Navigator, and Terminal

panes by pressing
Control+M (for Market
Watch), Control+N (for

Navigator), and Control+T | ommen [TFaverites 1 ||smbols [FRecchart T

(for Terminal). These

© Balance: 10 D00.00 Eguity: 10 000.00 Free margin: 10 000.00

panes can also be opened from the View menu.

11.At the top of the Market Watch window, right click on the word “Symbol” and
click on “Show All” to display all currency pairs. Finally under the Tools menu,
select “Options,” click on the “Charts” tab, and uncheck “Save deleted charts to
reopen.” Press OK.
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Installing RoboMiner

1.

Navigate to the Forex-Goldmine
Home Page at http://forex-
goldmine.com/. Click on Member
Login under Main Menu.

Enter Your User ID and Password
to Log in, or click on the Join Now
link to obtain a User ID and
Password.

Once you have logged in, click on
Member Downloads under Main
Menu. Click on RoboMiner Expert
Advisor under Free Downloads
and follow the instructions to
download the Expert Advisor.

Open the Zip file and extract the
RoboMiner.ex4 file to the /experts
folder in the folder in which
Metatrader was installed.

If Metatrader was running, close it
now and restart. From the Market
Watch (Control-M), select
AUDNZD to open the first chart. It
will display with a 1 hour (H1)
timeframe.

Display the Navigator (Control-N
or View->Navigator. Drag the
RoboMiner from the Expert
Advisors branch of the Navigator
tree onto the open AUDNZD chart.

In the open RoboMiner dialogue
box, under the Common tab,
place a check beside Allow Live
Trading. This will allow the
RoboMiner Expert Advisor to trade
on the chart.
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10.

11.

12.

Under the Inputs tab, enter the
unlock code—21434229268640
for the demo version—in the
appropriate space. This will unlock
the RoboMiner Expert Advisor.
Press OK to close the dialogue
box.

To turn on Expert Advisors,
ensure that the Expert Advisors
button on the Metatrader toolbar
is green. If it is red, click on it so
that it turns green. In the upper
right corner of the chart, the word
RoboMiner should appear,
followed by a happy face ©.

If an x appears in place of the
happy face, double check that the
Expert Advisors button on the
Metatrader toolbar shows a green
hat and arrow. Click on it if it does
not.

If a frowny face ® appears in
place of the happy face, open the
dialogue box (by pressing F7),
click on the Common tab, and
make sure that there is a check
next to Allow Live Trading. Press
OK to close the dialogue box.

To trade on a second currency
pair, repeat steps 5-8, substituting
EURCHF for AUDNZD. In addition,
change the first digit of the magic
number in the second dialogue
box (on the EURCHF chart) in
order to avoid conflict with trades
opened on the other pair
(AUDNZD).
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Using RoboMiner

RoboMiner user settings are made in the dialogue box. To open the dialogue box, select
the chart on which you want to adjust RoboMiner settings, and press F7. Once you
have made changes to the settings, save the new settings by pressing OK.

User Settings

EmergencyCloseAllTrades (default = false)

If set to true, will close all open trades. Only for use in
emergency situations.

DisplayLevel (default = 0)

Determines the trading range reflected in the on-chart
display. The default value (0) displays information for
the current price range.

UnlockCode

Enter the unlock code that you received in the
UnlockCode field. RoboMiner will not function without a
proper unlock code.

AllowForSpread (default = true)

Adjusts the trade ranges to allow for broker spread.

FIFO (default = false)

When set to true, Robominer will trade in compliance
with NFA first-in-first-out requirement. Default value
trades normally. Please determine whether your broker
requires FIFO before making this setting.

EquityPercentTakeProfit (default = 101.5)*

When FIFO is set to true, Robominer opens all trades
without entering any take profit values. Instead, it
calculates an aggregate profit for all trades as a
percentage of the account balance. When this
aggregate profit reaches the value set here, Robominer
closes all trades at once, in compliance with FIFO. The
default value of 1.5% (100+1.5) is a recommended
value only, and can be adjusted by the user.

DoTrades (default = true)

The default value of true will allow RoboMiner to open
trades. If this is set to false, RoboMiner will be turned
off, and will not open any new trades.

BalanceFactor (default = 0.0)

A value of 0.0 allows RoboMiner to calculate lot size
automatically. A value of 2000 or greater forces
RoboMiner to calculate lot size from the BalanceFactor
value. RoboMiner will increment the number of lots
traded every time the balance reaches a multiple of this
amount. The higher the value, the more conservative
the lot size progression.

Lots (default = 0.0)

A value of 0.0 allows RoboMiner to calculate lot size
from the BalanceFactor. Any other value sets a fixed lot
size.

MagicNumberl

The number series assigned to trades opened so that
RoboMiner can control exits. If RoboMiner is attached
to more than one currency pair, the first two digits of
magic numbers must be changed so that each instance
of RoboMiner will control its own trades. Use this
feature when trading on both AUDNZD and EURCHF.
Magic number must end in 001.

* With FIFO set to true, RoboMiner Il will remove the takeprofit from existing trades and start

monitoring them for the aggregate profit value set in EquityPercentTakeProfit in order to close them
all. Of course, MagicNumberl must be set to the same value in order for it to recognize older trades.
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Money Management and Safety

RoboMiner is designed to be as safe
as possible, although no forex trading
system can be 100% safe. Consequently,
it is highly recommended that users
withdraw %% of any profits generated at
the end of each month from their

accounts, and set this money aside. This
should be done until an amount
equivalent to the original investment has
been withdrawn. At this point, only profits
are being traded, and the original
principal can no longer be lost.

If BalanceFactor is used to calculate lot size on a single pair, it should be set to $2000 or higher
($2500 for EURCHF) so that no more than 0.01 standard lots are traded per $2000 of account
balance. When RoboMiner trades both the AUDNZD and EURCHF pairs and BalanceFactor is used to
control lot size, BalanceFactor must be set to a value of at least $3500.

How RoboMiner Works

The objective in designing
RoboMiner was to achieve a risk level in
forex trading comparable to other forms
of investment. The method used by
RoboMiner is grid trading, and the pairs
selected exhibit relatively narrow
historical trading ranges—in each case,
a total range of about 2640 pips. This
2640 pip range is divided into 66 sub-
ranges, corresponding to the size of an
average wave in each pair.

Above the centre point of the range,
RoboMiner opens only sell (short)
trades, and below the centre it opens
only buy (long) trades. If the pair
remains within its 2640 pip historical
range, no more than 33 trades can
remain open at a loss, creating a
drawdown on the account balance. (No
trade will be closed until it is 40 pips in
profit.) The total accumulated
drawdown for AUDNZD would then be
$1525 ($2319 for EURCHF). As long as
the account balance covers this
potential drawdown (plus an extra
margin of safety), the likelihood of a
margin call and loss of funds is kept to a
manageable minimum.

RoboMiner will open long positions
when the price is below the centreline
and short positions when the price is
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above the centreline, closing each trade
when it reaches its profit objective (40
pips). Trades that remain open will not
result in a margin call as long as the
drawdown is covered by the account
balance. To ensure that the drawdown
IS not excessive, the minimum values of
BalanceFactor and LotSize must be
strictly observed. We recommend
trading both pairs (AUDNZD and
EURCHF) if possible for an added
measure of safety.

When Balancefactor is set to zero,
RoboMiner operates as if the balance
were $3,500 as long as the actual
account balance remains relatively low.
This figure is increased by steps up to a
maximum $7,500 when the actual
account balance reaches $100,000 and
safety becomes more important than
growth.

Details of the calculations involved
in the design of RoboMiner are given in
the document titled “Proof.”

Automated Balance Factor Settings

Account Balance Balance Factor
$12,000 or less $3,500
$12,000 to $22,500 $4,000
$22,500 to $35,000 $4,500
$35,000 to $60,000 $5,000
$60,000 to $100,000 $6,000
$100,000 and over $7,500
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Forex VPS: Trading with Security
RoboMiner can operate on a Virtual Personal Server (VPS) for added security. A VPS is a secure server
on which you can open a personal account for trading with Metatrader Terminal and RoboMiner

already installed.

With Forex VPS, your RoboMiner trading platform is hosted remotely from your computer, so when
you lose your Internet connection or experience computer down time due to maintenance or power
outages, your RoboMiner continues to trade uninterrupted.

Forex VPS offers three levels of service to suit the needs of all levels of trader. For additional
information or to open an account with Forex VPS, go to http://www.forexvps.com/?a_aid=fvps.

Recommended Minimum RoboMiner Works.” However, should

Account Size and Settings you wish to customize your RoboMiner
Most traders will prefer to run account and settings, here are a few

RoboMiner with the default settings, as avall%blef[r?ptlons and the brokers that
described in the section on “How provide them.

Start Actual Balance | Lotsize Broker currenc Leverage
Balance Lot Size Factor Setting Y 9
- 2000 or ~ 400:1 or
$200 .01 mini 7610 0.01 IBFX AUDNZD 200:1
$350 .01 mini 35000r | 5 IBFX AUDNZD+EURCHF | 200:1or
Zero 200:1
.01 2000 or " 200:1, best
$2000 standard 710 0.01 FXDD AUDNZD 1001
.01 2500 or - 200:1, best
$2500 standard 7e10 0.01 FXDD EURCHF 1001
$3500 01 3500 0r 1 09 Alpari AUDNZD+EURCHF | 100:1t
standard Zero
$12K 03 40000r | 55 Alpari AUDNZD+EURCHF | 100:1t
standard Zero
$40K .1 standard | 5000 0.1 FXCM (ECN) | AUDNZD/EURCHF 400:1
$40K .1 standard | 5000 0.1 FXPro AUDNZD/EURCHF 500:1**

* Trading a single currency pair is not recommended unless there is not enough money in the
account to trade both pairs.

** EXPro offers only .1 mini lot sizes, so a $20K balance is required to trade a single pair.

t Although it is possible to trade at 100:1, this practice is not recommended.
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Broker Requirements

When selecting a broker for live
trading, please bear in mind that
RoboMiner requires a broker that is not
a dealer desk. This requirement is
important since RoboMiner never loses
trades. Consequently if the broker is
taking trades against you (i.e., is a
dealer desk), it will always lose. This
results in a hostile relationship with the
broker, which may then refuse to pass
through RoboMiner trades.

The broker should have micro lot
trading capabilities (i.e., be able to
accept .01 lot trades), and should offer
at least 200:1 margin leverage. Lastly,
the broker should be big enough that it
is not in danger of closing. At this time,
we can recommend IBFX and FXDD.

Why an Introducing Broker?

Brokers always want to attract new
traders and, or course, keep the ones
they have. It is a great inconvenience
for a broker if you close out your trades

and move your funds to another broker.

When you as an individual are not
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satisfied and do switch brokers, the
broker loses only one account. But if
you open an account through a good
Introducing Broker (IB) you have a bit
more clout. Not only would the broker
lose your account, but the Introducing
Broker could also lose an account.
Moreover, if many customers are
dissatisfied, the broker might not
receive new referrals from that IB.
Brokers thus tend to pay attention when
an IB speaks on your behalf. What's
more, the IB is more familiar with your
broker and its limitations. Your IB may
be able to help you directly, or refer the
case to a more advanced or better
trained liaison called an institutional
assistant or manager. The IB is paid by
the broker for bringing in accounts and
maintaining good relations (helping
clients) on their behalf. It costs the
trader nothing to use the services of an
IB.

We recommend www.fxrebates.com
as an Introducing Broker for Robominer
traders.
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ChangeProfit: Making Drawdown Work for You

As RoboMiner trades one or both of the pairs (AUSNZD or EURCHF), the price
for a pair may occasionally move well away from centre, and even approach
its historical limits. This will result in a large drawdown due to open trades.
When a large drawdown does accumulate, RoboMiner can generate a small
bonus if you simply change the magic number in the EA. The price may
continue to move away from centre, and RoboMiner will go on opening new
trades under the new magic number. When the currency price reverses and
moves toward centre again, the drawdown will begin to decrease. The take
profit associated with the old trades will close them, and RoboMiner will open
and close new trades with the new magic number. This in effect doubles your
profits with only one extra open trade at any given time.

To compound this effect, you can change the take profit for the old magic
number to 100 pips or so. This will add two to three extra trades at any given
time, but your profits will double again because there is no extra spread to
pay, and each trade will eventually close for a 100 pip gain. After the first
trade has closed, for every 40 pips the price moves back toward centre
RoboMiner will realize a 100 pip profit.

To automate this process, a helper EA called ChangeProfit is available to
RoboMiner traders in the files area of the Forex-Assistant group site:
http://finance.groups.yahoo.com/group/forex_assistant.

Simply extract the ChangeProfit file to the /experts sub folder of your
Metatrader folder, restart Metatrader, open a new chart for the pair to which
you want apply ChangeProfit, and attach the ChangeProfit EA to the chart. If
you decide to release existing open trades to close at a new take profit allow
RoboMiner to start a new series of trades, first copy and paste the old magic
number from the RoboMiner EA dialogue box on the currency pair chart into
the ChangeProfit dialogue box on the new chart for the same pair (highlight
and use right click). Set the number of instances (say, 60) and new take profit
(e.g., 100) and press OK. Then return to the RoboMiner EA and change the
magic number (e.g., to 520001 from 510001) and press OK. RoboMiner has
now released the old trades and will proceed to open a new series. Return to
the other chart and open the ChangeProfit dialogue box. Set DoChange to
“true” and press OK. The take profit for the entire series of open trades will
change to the value you entered.

Once the take profit has changed you may reset DoChange to “false” and the
old trades will close when they hit the new take profit you have assigned to
them. RoboMiner will open and close trades with the new magic number you
have entered at its own take profit.
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On Chart Display

RoboMiner displays information on the currency pair chart in order to keep you
informed of its status and trading. The on-chart information is summarized in the

following table:

RoboMiner x.xx

EA name and release number

http://www.forex-goldmine.com

Goldmine web address

Current Bid price

The price right now

Current Range

The range RoboMiner is trading. There are 66 ranges, made up of 33
buys and 33 sells. E.g., range 35, starting from the bottom-most
range, is just above center.

Long (Short) Open for Range xx

The value at which a new trade will open in the current range.

Long (Short) Close for Range xx

The value at which a trade in the current range will close.

RangeStart

The price lowest price within that particular range.

RangeEnd The highest price within that particular range.

First Range The bottom-most range that RoboMiner will trade as entered in the
magic number id.

Last Range The highest price range in which RoboMiner will still take a trade, and
the total number of ranges.

BalanceFactor A quick reminder of the BF value set in the EA dialogue box.

Ranges Setting

Although the range setting option has been removed from the setup
box on release 2.12, this tells you that the robot will trade the entire
area between the historical limits.

Trade Range

The number of pips that make up each separate range.

Trade Window

The number of pips from the open position that the RoboMiner will still
open a trade. In case of spikes or rapidly moving prices, we don't
want to try to place a trade. This feature will prevent that from
occurring. (e.g., 0.0005 = 5 pips)

Price 90 Day High

The highest price reached within the last quarter.

Price 90 Day Low

The lowest price reached within the last quarter.

Price 90 Day Midrange

Price and (range) at the midpoint of the previous 90 day high and low
for that same time.

Profit for this instance of EA

Profit for the current trade range at the current price. A negative
number means that the price has not reached the spread.

Profit for this Currency Pair

Level of profit or loss due to open/closed trades for this pair.

Lots1

The lot size of the trade for the current range, the currency pair being
traded, the magic number for the range.

Net Total Lots

The total impact of all trades of this type, as though the EA had
opened only one trade of the combined number of lots.

LotSize

Number of base units (pips) it takes to make one lot. A standard lot is
100,000 and a mini lot is 10,000.

Account Leverage

The leverage your broker has you set for.

Decimals

Decimal places your broker offers. Almost all brokers now allow
smaller trades than 1 full lot. A mini trade is .1 lots or 1 decimal place
and a micro is .01 lots or 2 decimal places. Although no broker offers
it yet, a nano lot would be .001 lots or 3 decimal places. The IBFX .01
lot on its mini account (10,000 base currency per lot) is best referred
to as a micro-mini, since it is 2 decimal places on a mini account.

DoTrades

If true, the robot will trade when the price is hit and the expert button
is green, allowing the order to be sent.

Open Forward Orders

If true, the robot will open buy (long) trades. The number of ranges it
will trade is shown in brackets.

Open Reverse Orders

If true the robot will open sell (short) trades. The number of ranges it
will trade is shown in brackets.
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